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Safety messages

NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum product performance,
ensure you thoroughly understand the contents before installing, using, or maintaining this product.

For technical assistance, contacts are listed below:

Customer Central

Technical support, quoting, and order-related questions.

• United States - 1-800-999-9307 (7:00 am to 7:00 pm CST)

• Asia Pacific- 65 777 8211

North American Response Center

Equipment service needs.

• 1-800-654-7768 (24 hours a day — includes Canada)

• Outside of these areas, contact your local Emerson representative.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained personnel, in accordance with the
applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

 WARNING

Physical access

Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’ equipment. This could
be intentional or unintentional and needs to be protected against.

Physical security is an important part of any security program and fundamental to protecting your system. Restrict physical access
by unauthorized personnel to protect end users’ assets. This is true for all systems used within the facility.

 CAUTION

Hot surfaces

The transmitter and process seal may be hot at high process temperatures. Allow to cool before servicing.
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1 Introduction

1.1 Using this manual
The sections in this manual provide information on installing, operating, and maintaining
the Rosemount™ 1208A Level and Flow Transmitter – Non-Contacting Radar.

The sections are organized as follows:

Transmitter overview provides an introduction to theory of operation, a description of the
transmitter, information on typical applications, and process characteristics.

Mechanical installation contains mechanical installation instructions.

Electrical installation contains electrical installation instructions.

Configuration provides instructions on configuration of the transmitter.

Operation and maintenance contains operation and maintenance techniques.

Service and troubleshooting provides troubleshooting techniques for the most common
operating problems.

Specifications and reference data supplies reference and specification data.

Configuration parameters provides extended information about the configuration
parameters.

1.2 Product certifications
See the Rosemount 1208A Product Certifications document for detailed information on
the existing approvals and certifications.

1.3 Open source licenses
This device uses open source software. Further information can be found in the
License Information document available at Emerson.com/Rosemount.

1.4 Product recycling/disposal
Recycling of equipment and packaging should be taken into consideration and disposed of
in accordance with local and national legislation or regulations.

Related information

Service support
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2 Transmitter overview

2.1 Measurement principle
The Rosemount 1208A is a transmitter for continuous level measurements using fast-
sweep Frequency Modulated Continuous Wave (FMCW) technology.

The transmitter continuously emits signal sweeps with a constantly varying frequency
towards the product surface. Since the transmitter continuously changes the frequency of
the transmitted signal, there will be a difference in frequency between the transmitted
and the reflected signals (see Figure 2-1).

The frequency of the reflected signal is subtracted from the frequency of the signal
transmitted at that moment, resulting in a low frequency signal which is proportional to
the distance to the product surface. This signal is further processed to obtain fast, reliable,
and highly accurate level measurements.

Figure 2-1: FMCW-method
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The Rosemount 1208A can also calculate the volume flow rate in an open channel.

2.2 Process characteristics

2.2.1 Dielectric constant
A key parameter for measurement performance is reflectivity. A high dielectric constant of
the media provides better reflection and enables a longer measuring range.
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2.2.2 Foam and turbulence
Foaming liquids or turbulence may cause weak and varying surface echo amplitudes.
Surface turbulence is not normally a problem unless it is excessive.

Measurement in foamy applications depends largely on the foam properties. When the
foam is light and airy, the actual product level is measured. For heavy and dense foam, the
transmitter may measure the level of the foam’s upper surface.

2.3 Vessel characteristics

2.3.1 In-tank obstructions
The transmitter should be mounted so that objects such as heating coils, ladders, and
agitators are not in the radar signal path. These objects may cause false echoes resulting in
reduced measurement performance. However, the transmitter has built-in functions
designed to reduce the influence from disturbing objects where such objects cannot be
totally avoided.

Vertical and inclined structures cause minimal effect since the radar signal is scattered
rather than directed back to the antenna.

2.4 Non-contacting radar technology
Non-contacting radar technology is ideal for a wide range of applications as it is
maintenance-free, has a top-down installation that reduces the risk of leakages, and is
unaffected by process conditions such as density, viscosity, temperature, pressure, and
pH.

The Rosemount 1208A uses Frequency Modulated Continuous Wave (FMCW) technology
and smart algorithms to maximize measurement accuracy and reliability, even in small
tanks and challenging fast-filling vessels.
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2.4.1 Application examples
Storage tanks

Gain insights into your tank and ensure production runs smoothly without interruption.

Plastic tanks

Monitor the inventory of your small and medium sized plastic tanks by measuring through
the plastic roof.

Open air applications

Get reliable level measurements of sumps or ponds, regardless of challenging surface and
weather conditions.
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Open channel flow

Use the Rosemount 1208A for volume flow measurement of water and wastewater in
open channels.

2.5 Components of the transmitter
Figure 2-2: Components
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A. M12 male connector (A-coded)
B. Transmitter housing
C. Gasket
D. NPT 1½-in. or ISO 228/1-G1½-in. thread
E. Antenna

Related information

Dimensional drawings

2.6 Easy integration with IO-Link
The Rosemount 1208A provides both conventional 4-20 mA and digital switch outputs,
enabled by IO-Link connectivity. This supports easy integration into any automation
system.

Each IO-Link system consists of an IO-Link master and one or more IO-Link devices (sensors
and actuators). The connection between the master and the device is established via
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unshielded standard cables using standard connectors such as M12. Process data, events
and parameters are transferred to the master via IO-Link. The IO-Link master then
transfers the data to the controller (PLC) and its fieldbus or industrial ethernet network.

Figure 2-3: Example of an IO-Link System
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A. Industrial ethernet
B. Programmable logic controller (PLC)
C. Industrial Fieldbus
D. IO-Link master
E. IO-Link devices

Reference Manual Transmitter overview
00809-0100-7062 October 2022

Reference Manual 11



Transmitter overview Reference Manual
October 2022 00809-0100-7062

12 Rosemount 1208A Level and Flow Transmitter



3 Mechanical installation

3.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

3.2 Installation considerations
Before installing the transmitter, follow recommendations for mounting position,
sufficient free space, nozzle requirements, etc.

3.2.1 Mounting position
When finding an appropriate location on the tank for the transmitter, the conditions of the
tank must be carefully considered.

Consider the following guidelines when mounting the transmitter:

• For optimal performance, the transmitter should be installed in locations with a clear
and unobstructed view of the product surface.
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• The transmitter should be mounted with as few internal structures as possible within
the signal beam.

• Do not mount close to or above the inlet stream.

• Do not mount the transmitter on a manway cover.

• Do not position the transmitter directly over a side manway door.

• Multiple Rosemount 1208A transmitters can be used in the same tank without
interfering with each other.

Figure 3-1: Recommended Mounting Position

L

3.2.2 Free space requirements
If the transmitter is mounted close to a wall or other tank obstruction such as heating coils
and ladders, noise might appear in the measurement signal. See Table 3-1 for
recommended clearance.

Figure 3-2: Free Space Requirements

L

Table 3-1: Distance to Tank Wall (L)

Minimum Recommended

8 in. (200 mm) ½ of tank radius
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3.2.3 Inclination
The transmitter should be mounted vertically to ensure a good echo from the product
surface. See Figure 3-3 for recommended maximum inclination.

Figure 3-3: Inclination

90°

Max. 3°

3.2.4 Non-metallic tanks
Nearby objects outside the tank may cause disturbing radar echoes. Wherever possible,
the transmitter should be positioned so that objects close to the tank are kept outside the
signal beam.
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3.2.5 Beam angle and beam width
The transmitter should be mounted with as few internal structures as possible within the
signal beam.

Figure 3-4: Beam Angle and Beam Width

D

W

Beam angle (α)

8°

Beam width

See Table 3-2 for beam width at different distances.

Table 3-2: Beam Width

Distance (D) Beam width (W)

6.6 ft. (2 m) 0.9 ft. (0.3 m)

13.1 ft. (4 m) 1.8 ft. (0.6 m)

19.7 ft. (6 m) 2.8 ft. (0.8 m)

26.2 ft. (8 m) 3.7 ft. (1.1 m)

32.8 ft. (10 m) 4.7 ft. (1.4 m)
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3.2.6 Nozzle requirements
To allow the microwaves to propagate undisturbed, the nozzle dimensions should be kept
within the specified limits as given in Table 3-3. The inside of the nozzle must be smooth
(i.e. avoid bad welding, rust, or deposit).

Figure 3-5: Mounting in Nozzles

D

H

Table 3-3: Nozzle Requirements

Nozzle diameter (D) Maximum nozzle height (H)

1.5 in. (40 mm) 5.9 in. (150 mm)

2 in. (50 mm) 7.9 in. (200 mm)

3 in. (80 mm) 11.8 in. (300 mm)

4 in. (100 mm) 15.8 in. (400 mm)

6 in. (150 mm) 23.6 in. (600 mm)
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3.3 Bracket mounting

3.3.1 Mount the standard bracket
Procedure

1. Mount the bracket on the pipe/ceiling/wall.

On pipe:

13 mm

or

On ceiling/wall:

T30
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2. Ensure the adjustable holder is directed toward the ground.

T30

90°

3. Install and hand tighten the transmitter.

Related information

Bracket hole pattern
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3.3.2 Mount the extendable bracket
Procedure

1. Mount the bracket on the pipe/wall.

On pipe:

13 mm

or

On wall:
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2. Mount the extendable arm.

Do not fully tighten the screws at this stage.

T30

3. Install and hand tighten the transmitter.
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4. Connect the M12 cable.

5. Ensure the adjustable holder is properly aligned.

T30
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6. Fold down the arm to a horizontal position.

7. Adjust the length of the arm as necessary. Then tighten the two screws.

T30
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8. Check that the bracket installation is level.

To raise or lower the arm, adjust the two level screws. Then tighten the two nuts.

T30 10 mm

9. Tighten the two screws.

T30

Related information

Bracket hole pattern
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3.4 Installing on a tank

3.4.1 Mount the flange
Procedure

1. Place a suitable gasket on the tank flange.

2. Place the flange over the gasket.

3. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

4. Apply appropriate thread sealant to the transmitter threads.

Note
Only for NPT threaded tank connection.
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5. Install and hand tighten the transmitter.

Note
The gasket is necessary for the G threaded version only.

3.4.2 Mount the NPT threaded adapter
Procedure

1. Apply appropriate thread sealant to the outer threads.

2. Mount the threaded adapter on the tank.

60 mm

3. Apply appropriate thread sealant to the transmitter threads.
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4. Install and hand tighten the transmitter.
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4 Electrical installation

4.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

4.2 Prepare the electrical connections

4.2.1 Connector type
M12 male (A-coded)

4.2.2 Power supply
The transmitter operates on 18-30 Vdc at the transmitter terminals.

Related information

Load limitations
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4.2.3 Outputs
The transmitter provides two configurable outputs:

Output 1 Digital output / IO-Link mode

Output 2 Digital output or active 4-20 mA analog output

4.2.4 Internal power consumption
< 2 W (normal operation at 24 Vdc, no outputs)

< 3.6 W (normal operation at 24 Vdc, digital and analog outputs active)

4.2.5 Wiring diagram

Figure 4-1: Connection
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Table 4-1: Pin Assignment

Pin Wire color(1) Signal

1 BN Brown L+ 24 V

2 WH White OUT2 Digital output or active 4-20 mA analog
output

3 BU Blue L- 0 V

4 BK Black OUT1/IO-Link Digital output or IO-Link mode

(1) According to IEC 60947-5-2.
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Figure 4-2: Example Circuits
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A. 2 x Digital output PnP
B. 2 x Digital output NpN
C. 1 x Digital output PnP / 1 x Analog output
D. 1 x Digital output NpN / 1 x Analog output

Related information

Outputs
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4.3 Power up transmitter
Procedure

1.  Verify the power supply is disconnected.

2. Insert the M12 connector and screw tight.

See the manufacturer’s instruction manual for recommended torque.

3. Connect the power supply.

Related information

Ingress protection
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5 Configuration

5.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

5.2 Overview
This chapter provides information about configuration and configuration tools. Appendix
Configuration parameters provides extended information about the configuration
parameters.

5.3 Connect the transmitter to the IO-Link
IO-Link devices can be set using an IO-Link USB Communicator, through the IO-Link
master, or via the PLC.

Procedure

Start the configuration software and connect the transmitter.
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Figure 5-1: Connection via the IO-Link USB Communicator

Figure 5-2: Connection via the IO-Link Master

Figure 5-3: Connection via the PLC

5.4 Get started with your preferred configuration
tool

5.4.1 IO-Link configuration tools
Examples:

• Rosemount IO-Link Assistant (available as accessory)

• FDT® frame applications, e.g. PACTware

5.4.2 Rosemount IO-Link Assistant

Get the latest IODD files
The Rosemount IO-Link Assistant software checks and lets you download the latest IODDs
for your device catalog.

Prerequisites

For an online update, an internet connection is required.

Procedure

1. Click the  icon.
The Device description files (IODD): download and install window opens.
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2. In the Vendor list, select Rosemount Inc., and then select the check box for the
devices to be installed/updated.

Alternatively, browse to an already downloaded IODD zip file, and select Open.

3. Select OK.

5.4.3 FDT®/DTM framework

Download the IODD file

Procedure

1. Download the IODD from the IODDFinder portal at Ioddfinder.io-link.com.

2. Unzip the IODD package.

Integrate IODDs into an FDT®/DTM framework
An IODD DTM Interpreter is required to integrate IODDs into an FDT/DTM environment
(e.g PACTware).

Prerequisites

The IODD DTM Interpreter is usually included in the FDT/DTM software installation
package. It can also be downloaded from Emerson.com/Rosemount1208A.

Procedure

1. Start the IODD DTM Interpreter software.
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2. Select Add IODD.

3. Browse to the IODD file (.xml) and select Open.

4. Start the configuration tool and update the device catalog.

Need help?
If the new DTM is not added automatically at start-up, then select View → Device
Catalog → Update Device Catalog.

5.5 Perform the basic setup

5.5.1 Set the engineering units
Procedure

1. Under Menu, select Parameter → Basic Setup.

2. In the Engineering Units list, select Metric or Imperial.

3. Select Write to device.

Related information

Engineering units

5.5.2 Enter the reference height
Procedure

1. Under Menu, select Parameter → Basic Setup.

2. Enter the Reference Height.

3. Select Write to device.
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Related information

Reference height

5.5.3 Configure the analog output
The transmitter can be set to output the level or volume flow as a 4-20 mA signal.

Procedure

1. Under Menu, select Parameter → OUT2 Analog Output.

2. In the OUT2 Configuration list, select Analog Output 4-20 mA.

3. In the Analog Control Variable list, select Level or Volume Flow.

4. In the Alarm Mode list, select Low Alarm or High Alarm.

5. Select Analog Range Values, and then enter the desired Upper Range Value (20
mA) and Lower Range Value (4 mA).

6. Select Write to device.

Related information

Analog output

5.5.4 Configure the digital output
The transmitter can be set to output a switching signal for high and low limits (using the
same pin).

Procedure

1. Under Menu, select Parameter → Basic Setup.

2. In the Digital Outputs P-n list, select PnP or nPn.

3. Select OUT1 Digital Output or OUT2 Digital Output.

4. In the OUT1 Configuration or OUT2 Configuration list, select Digital Output Normally
Open.

5. In the DO Control Variable list, select Level or Volume Flow.

6. Select Set Point Configuration, and then set the alarm parameters as desired.

7. Select Write to device.

Related information

Digital output

5.5.5 Set up the volume flow measurement
Procedure

1. Under Menu, select Volume Flow.

2. In the Volume Flow Calculation Method list, select the preferred method. Choose
from:
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• Linearization table

• Parshall flume

• Khafagi-Venturi flume

3. Select Volume Flow Table/Formula, and then set the parameters as desired.

4. Select Write to device.

Related information

Volume flow
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6 Operation and maintenance

6.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

6.2 View measurement data and events
The dashboard in Rosemount IO-Link Assistant displays the measured values, device
status, switching status for digital output (on/off), and events. The measured values and
switching states are visualized in a graph over a defined period of time.

Procedure

From the Overview screen, select Dashboard.
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Figure 6-1: Dashboard

Need help?
Select the Help  button for more information on the features and capabilities.

6.2.1 Measurement variables
Variable Description

Level The current level measurement value (from the Zero Level to the product
surface).

Distance The distance from the Device Reference Point to the surface.

Signal strength The reflected signal strength from the surface.

Electronics
temperature

The current temperature at the electronics.

Min electronics
temperature

The measured minimum electronics temperature.

Max electronics
temperature

The measured maximum electronics temperature.

Volume Flow The calculated volume flow value.

6.2.2 Interpret measurement status
A “Good” or “Bad” status next to a value is an indication of the reliability or integrity of the
data being received, not an indication of whether or not the value is within the configured
upper or lower ranges. A value that triggers an alert, such as a high or low temperature
indication, will change the overall status of the device, but the measurement might still be
indicated as “Good” if the reliability of the data is good.
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6.3 Enter the demonstration mode
In this mode, the signal processing method is optimized for demo situations when
simulating a product surface with, for example, a measurement target plate.

Note
This mode is intended for demonstration purposes only, and should not be used for
normal operations.

Prerequisites

The demonstration mode will reset the following parameters to factory settings:

• Measurement recovery time

• Damping value

When returning to Default Mode, you will therefore need to reconfigure these parameters
(if desired).

Procedure

1. Under Menu, select Parameter → Service Tools → Application Mode.

2. Select Enter Demonstration Mode.

Postrequisites

1. Select Exit Demonstration Mode to return to normal operation (Default Mode).

2. Verify that the Application Mode is set to Default Mode.

Reference Manual Operation and maintenance
00809-0100-7062 October 2022

Reference Manual 41



Operation and maintenance Reference Manual
October 2022 00809-0100-7062

42 Rosemount 1208A Level and Flow Transmitter



7 Service and troubleshooting

7.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

Reference Manual Service and troubleshooting
00809-0100-7062 October 2022

Reference Manual 43



7.2 Diagnostic messages

7.2.1 Device hardware fault
Alarm classification

Event Device hardware fault – Device exchange

Device status Failure

Class Error

Possible cause

An electronics error has occurred.

Recommended actions

1. Restart the device.

2. If the condition persists, replace the device.

Related information

Perform a device reset

7.2.2 Device software fault
Alarm classification

Event Device software fault – Check firmware revision

Device status Failure

Class Error

Possible cause

The software has detected an internal error.

Recommended actions

1. Restart the device.

2. Restore default settings and reconfigure the device.

3. If the condition persists, replace the device.

Related information

Perform a device reset
Restore to factory settings
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7.2.3 General power supply fault
Alarm classification

Event General power supply fault – Check availability

Device status Failure

Class Error

Possible cause

Power supply drops below 18 Vdc during transmitter start-up.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.

7.2.4 Parameter error
Alarm classification

Event Parameter error – Check data sheet and values

Device status Failure

Class Error

Possible cause

The device has detected a configuration error.

Recommended actions

1. If analog output is used, check Upper and Lower Range Values.

2. If digital output is used, check High and Low Alarm Set Points.

3. If volume flow table is used, check that the Level points are entered in
increasing order.

4. If condition persists, restore default settings and reconfigure the device.

Related information

Upper/lower range value
Alarm set points
Volume flow table
Restore to factory settings
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7.2.5 Device memory failure
Alarm classification

Event Device memory failure – Restore default settings

Device status Failure

Class Error

Possible cause

Configuration data has been corrupted, for example, due to a power loss during writing.

Recommended actions

1. Restore default settings, restart device, and reconfigure the device.

2. If the condition persists, replace the device.

Related information

Restore to factory settings
Perform a device reset

7.2.6 Simulation active
Alarm classification

Event Simulation active – Check operational mode

Device status Functional check

Class Warning

Possible cause

The device is in simulation mode and is not reporting actual information.

Recommended actions

1. If this behavior is not desired, stop simulation mode.

2. If the condition persists, restart the device.

Related information

Use the simulation mode
Perform a device reset
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7.2.7 Level measurement lost
Alarm classification

Event Level measurement lost – Check application

Device status Failure

Class Error

Possible cause

No valid level reading. Reasons may be multiple:

• No valid surface echo peak in the measuring range

• Incorrect device configuration

Recommended actions

1. Analyze the Echo Peaks and check device configuration, especially General
Threshold.

2. Check device physical installation (for instance antenna contamination).

3. Consider increasing Measurement Recovery Time parameter for intermittent
conditions.

4. Restore default settings, restart device, and reconfigure the device.

5. If the condition persists, replace the device.

Related information

Analyze the echo peaks
Adjust the general threshold
Measurement recovery time
Restore to factory settings
Perform a device reset

Reference Manual Service and troubleshooting
00809-0100-7062 October 2022

Reference Manual 47



7.2.8 Device temperature over-run
Alarm classification

Event Device temperature over-run – Clear source of heat

Device status Out of specification

Class Warning

Possible cause

The electronics temperature is outside the operating range.

Recommended actions

1. Verify ambient temperature is within the operating range.

2. Clear source of heat.

Related information

Ambient temperature

7.2.9 Device temperature under-run
Alarm classification

Event Device temperature under-run – Insulate device

Device status Out of specification

Class Warning

Possible cause

The electronics temperature is outside the operating range.

Recommended actions

1. Verify ambient temperature is within the operating range.

2. Insulate device.

Related information

Ambient temperature
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7.2.10 Short circuit
Alarm classification

Event Short circuit – Check installation

Device status Out of Specification

Class Error

Possible cause

Short circuit on the digital output.

Recommended actions

Check cable and connections.

7.2.11 Primary supply voltage over-run
Alarm classification

Event Primary supply voltage over-run – Check tolerance

Device status Out of specification

Class Warning

Possible cause

Supply voltage is too high.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.

7.2.12 Primary supply voltage under-run
Alarm classification

Event Primary supply voltage under-run – Check tolerance

Device status Out of specification

Class Warning

Possible cause

Supply voltage is too low.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.
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7.2.13 Maintenance required
Alarm classification

Event Maintenance required - Cleaning

Device status Maintenance required

Class Notification

Possible cause

Product build-up on the antenna.

Recommended actions

Clean the antenna.

Use a damp cloth and a mild cleaning agent suitable for the media and wetted parts of
the transmitter.

Related information

Material exposed to tank atmosphere
Components of the transmitter

7.2.14 Max EEPROM write cycles expired
Alarm classification

Event Max EEPROM write cycles expired – Check master and restart the
device

Device status Maintenance required

Class Warning

Possible cause

Frequent writing of parameters from master to device.

Recommended actions

1. Check the master configuration.

2. Restart the device.

3. If error persists, contact your local Emerson representative.

Related information

Perform a device reset
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7.2.15 Measurement range over-run
Alarm classification

Event Measurement range over-run – Check application

Device status Out of Specification

Class Error

Possible cause

The level measurement is outside the configured range for the volume flow.

Recommended actions

Ensure that level values within operating range are included in the volume flow table.
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7.3 Troubleshooting incorrect level readings

7.3.1 Reported level is too high or low

Figure 7-1: Symptom
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Possible cause

Incorrect tank geometry configuration.

Recommended actions

• Verify the tank geometry parameters are configured correctly (especially the
Reference Height).

• Analyze the Echo Peaks and check General Threshold.

• Restore default settings and reconfigure the device.

Related information

Reference height
Analyze the echo peaks
Adjust the general threshold
Restore to factory settings
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7.3.2 Level is stuck in measuring range

Figure 7-2: Symptom
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Possible cause

Disturbing object in the tank.

Recommended actions

• Analyze the Echo Peaks and check General Threshold.

• Remove the disturbing object.

• Put an inclined metal plate on top of the disturbing object.

• Move the transmitter to another position.

Related information

Analyze the echo peaks
Adjust the general threshold
Mounting position
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7.3.3 Level is stuck in full tank

Figure 7-3: Symptom
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Possible cause

Disturbing object near the antenna.

Recommended actions

• Analyze the Echo Peaks and check General Threshold.

• Increase the Upper Null Zone.

• Remove the disturbing object.

• Move the transmitter to another position.

Possible cause

Product build-up on the antenna.

Recommended actions

• Clean the antenna.

Related information

Analyze the echo peaks
Adjust the general threshold
Change the upper null zone
Mounting position
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7.3.4 Level value drops when close to antenna
Symptom

Level value drops to a lower value when product surface is close to antenna.

Figure 7-4: Symptom
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Possible cause

Product surface is within the Upper Null Zone and a disturbance echo is interpreted as the
product surface.

Recommended actions

• Check the setting of the Upper Null Zone.

Related information

Change the upper null zone

Reference Manual Service and troubleshooting
00809-0100-7062 October 2022

Reference Manual 55



7.3.5 Measured level fluctuates

Figure 7-5: Symptom
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Possible cause

Excessive foaming or turbulence.

Recommended actions

• Under turbulent conditions with low level rates, consider increasing the Damping
value.

Related information

Damping value
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7.3.6 Measured level is occasionally unstable

Figure 7-6: Symptom
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Possible cause

The product surface is close to a suppressed false echo.

Recommended actions

• If possible, remove the disturbing object.

Related information

Analyze the echo peaks
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7.3.7 Lagging of measured level
Symptom

Measured level lags during rapid level changes.

Figure 7-7: Symptom
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Possible cause

Damping value is set too high.

Recommended actions

• If there is a problem with lag during rapid level changes, consider decreasing the
Damping value.

Related information

Damping value
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7.3.8 Incorrect level at 100% (20 mA)
Symptom

Measured level is correct at 0% (4 mA) but incorrect at 100% (20 mA).

Figure 7-8: Symptom
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Possible cause

Upper Range Value is not set correctly.

Recommended actions

• Check that the Upper Range Value matches the 100% (20 mA) level in the tank.

Related information

Upper/lower range value
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7.3.9 Incorrect level when product surface is above 50%
Symptom

The reported level is incorrect when the product surface is above the 50% level.

Figure 7-9: Symptom
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Possible cause

A strong double bounce echo is interpreted as the product surface.

Recommended actions

• Move the transmitter to another position.

Related information

Mounting position
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7.3.10 Dropping of level close to tank bottom
Symptom

Measured value drops to zero level in the tank bottom region.

Figure 7-10: Symptom
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Possible cause

Transmitter has locked on a strong tank bottom echo.

Recommended actions

• Verify the Reference Height is configured correctly.

Related information

Reference height
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7.3.11 Level measurement lost in a manway cover installation
Symptom

The transmitter reports "Level measurement lost" when opening/closing the manway
cover.

Figure 7-11: Symptom
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Possible cause

If mounted on a manway cover, the transmitter may lock on a disturbance echo and report
this as surface level when the cover is opened. After closing the cover, the echo is lost and
the transmitter reports "Level measurement lost".

Recommended actions

• Before opening the manway cover, disconnect power to the transmitter.

• After closing, restart the device.

• Move the transmitter to another position.

Related information

Mounting position
Perform a device reset
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7.3.12 Level measurement is lost in an empty tank
Symptom

The transmitter reports "Level measurement lost" in an empty tank after closing the side
manway door.

Figure 7-12: Symptom
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Possible cause

When the manway door is opened inward, it generates a disturbance echo which is
interpreted as the product surface echo. After closing the door, the echo is lost and the
transmitter reports "Level measurement lost". The message is cleared when start filling the
tank.

Recommended actions

• Before opening the manway door, disconnect power to the transmitter.

• After closing, restart the device.

• Move the transmitter to another position.

Related information

Mounting position
Perform a device reset
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7.3.13 Alarm mode close to tank bottom
Symptom

When the product surface is near the sloped tank bottom, the transmitter enters alarm
mode.

Figure 7-13: Symptom
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Possible cause

Reduction of projected surface area close to sloping tank bottom.

Recommended actions

• Verify the tank geometry parameters are configured correctly (especially the
Reference Height and Bottom Offset).

Related information

Reference height
Bottom offset

7.4 Managing disturbance echoes
There are two general methods for managing disturbance echoes:

• Set general threshold to filter out weak disturbance echoes and noise.

• Increase the Upper Null Zone to block out disturbance echoes at the top of the tank.
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7.4.1 Adjust the general threshold
If necessary, the general threshold value can be increased if a disturbance echo is
interpreted as the product surface. Alternatively, a lower threshold may be required to
handle weak surface echoes (e.g. due to excessive foaming or turbulence).

Prerequisites

The general threshold is set at factory for optimum performance and should not normally
need an adjustment.

Before changing the factory default value, study the position and amplitude of the
different echo peaks.

Procedure

1. Under Menu, select Parameter → Advanced Setup.

2. In the General Threshold box, enter the desired value.

3. Select Write to device.

Related information

Analyze the echo peaks
General threshold

7.4.2 Change the upper null zone
The Upper Null Zone defines a zone close to the transmitter where echoes are ignored.
This zone can be extended to block out disturbing echoes at the top of the tank.

Prerequisites

Note
Make sure the Upper Range Value (100%/20 mA) value is below the Upper Null Zone.
Measurements are not performed within the Upper Null Zone.

Procedure

1. Identify desired Upper Null Zone by analyzing the echo peaks.

a) Under Menu, select Diagnosis → Echo Peaks.

b) View the echo peaks to find out if there are disturbing echoes close to tank
top.

2. Set the desired Upper Null Zone value.

a) Under Menu, select Parameter → Geometry → Advanced.

b) Enter the desired Upper Null Zone value.

c) Select Write to device.

Related information

Analyze the echo peaks
Upper null zone
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7.5 Service and troubleshooting tools

7.5.1 Analyze the echo peaks
Measurement problems can be understood by studying the position and amplitude of the
different peaks.

Procedure

Under Menu, select Diagnosis → Echo Peaks.

Echo peaks
See Table 7-1 for a list of possible echo peaks.

Table 7-1: Echo Peak Types

Type Description

Surface Echo tracked as the current surface echo

Unknown Echo identified as unknown (can be a surface candidate)

Suppressed Echoes that are identified but suppressed by the device

Tank bottom echo Echo considered as an echo from the tank bottom

7.5.2 Perform a device reset
The function is used to reset/restart the electronics without re-cycling the power.

Procedure

1. Under Menu, select Parameter → Service Tools → Maintenance.

2. Select Device Reset.

7.5.3 Restore to factory settings
This function restores the transmitter to factory settings (user configuration is
overwritten).

Procedure

1. Under Menu, select Parameter → Service Tools → Maintenance.

2. Select Restore Factory Settings.

7.5.4 Use the simulation mode
It is possible to set the level to a simulated value for testing purposes. The simulated value
affects both digital and analog output.

Procedure

1. Under Menu, select Parameter → Service Tools → Simulation.
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2. In the Simulated Level box, enter the desired value.

This value will also be used for the volume flow calculation.

3. Select Write to device.

4. Select Start simulation (60 min).

7.5.5 Calibrate analog out
Use this function to calibrate the analog output by comparing the actual output current
with the nominal 4 mA and 20 mA currents. Calibration is done at factory and the analog
output does not normally need to be recalibrated.

Prerequisites

Connect a calibrated ampere meter to the analog output loop.

Procedure

1. Under Menu, select Parameter → Service Tools → Analog Out Calibration.

2. Perform the calibration of 4 mA.

a) Select Enter 4 mA Fixed Current Mode to set the analog out to 4 mA.

b) Measure the analog output with the ampere meter.

c) In the 4 mA Measured Current box, enter the measured current.

d) Select Write to device.

e) Select Calibrate 4 mA.

f) Measure the analog output with the ampere meter and verify it is within
4±0.01 mA.

3. Perform the calibration of 20 mA.

a) Select Enter 20 mA Fixed Current Mode to set the analog out to 20 mA.

b) Measure the analog output with the ampere meter.

c) In the 20 mA Measured Current box, enter the measured current.

d) Select Write to device.

e) Select Calibrate 20 mA.

f) Measure the analog output with the ampere meter and verify it is within
20±0.01 mA.

4. Select Exit Fixed Current Mode.

7.6 Service support
To expedite the return process, refer to Emerson.com and contact the nearest Emerson
representative.
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 CAUTION

Individuals who handle products exposed to a hazardous substance can avoid injury if they
are informed of and understand the hazard. Returned products must include a copy of the
required Safety Data Sheet (SDS) for each substance.

Emerson representatives will explain the additional information and procedures necessary
to return goods exposed to hazardous substances.
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A Specifications and reference data

A.1 Performance specifications

A.1.1 General

Reference conditions
• Measurement target: Stationary metal plate, no disturbing objects

• Temperature: 59 to 77 °F (15 to 25 °C)

• Ambient pressure: 14 to 15 psi (960 to1060 mbar)

• Relative humidity: 25-75%

• Damping: Default value, 2 s

Instrument accuracy (under reference conditions)
±0.08 in. (±2 mm)(1)

Repeatability
±0.04 in. (±1 mm)

Ambient temperature effect
±0.04 in. (±1 mm)/10 K

Sensor update rate
Minimum 1 update per second (typically 5 updates per second)

Maximum level rate
200 mm/s

A.1.2 Measuring range

Maximum measuring range
49 ft. (15 m)(2)

(1) Refers to inaccuracy according to IEC 60770-1 when excluding installation dependent offset. See the IEC 60770-1 standard
for a definition of radar specific performance parameters and if applicable corresponding test procedures.

(2) The measuring range is limited to 33 ft. (10 m) for oil-based media (dielectric constant < 10). Also note that a combination
of adverse process conditions, such as heavy turbulence, foam, and condensation, together with products with poor
reflection may affect the measuring range.
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Accuracy over measuring range
Figure A-1 illustrates the accuracy over measuring range at reference conditions.

Figure A-1: Accuracy Over Measuring Range

±0.08 
(±2)

±0.4
(±10)

5.9 (150)

BA

C

A. Device Reference Point
B. Accuracy in inches (millimeters)
C. Distance in inches (millimeters)

A.1.3 Environment

Vibration resistance
2 g at 10-1000 Hz according to IEC 61298-3, level “field with general application”

Electromagnetic compatibility (EMC)
• EMC Directive (2014/30/EU): EN 61326-1

• NAMUR recommendations NE21 (only 4-20 mA output)

Pressure Equipment Directive (PED)
Complies with 2014/68/EU article 4.3

Radio approvals
• Radio Equipment Directive (2014/53/EU) and Radio Equipment Regulations (S.I.

2017/1206):
— ETSI EN 302 372

— ETSI EN 302 729

— EN 62311

• Part 15 of the FCC Rules

• Industry Canada RSS 211
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Related information

Product certifications

A.2 Functional specifications

A.2.1 General

Field of application
Continuous measurement of level and open channel flow.

Minimum dielectric constant
2

Measurement principle
Frequency Modulated Continuous Wave (FMCW)

Frequency range
77 to 81 GHz

Maximum output power
3 dBm (2 mW)

Internal power consumption
< 2 W (normal operation at 24 Vdc, no outputs)

< 3.6 W (normal operation at 24 Vdc, digital and analog outputs active)

Humidity
0 - 100% relative humidity, non-condensing

Turn-on time
< 15 s(3)

A.2.2 Outputs
The transmitter provides two configurable outputs:

Output 1 Digital output / IO-Link mode

Output 2 Digital output or active 4-20 mA analog output

(3) Time from when power is applied to the transmitter until performance is within specifications.
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A.2.3 Digital output
Switching signal for high and low limits (using the same pin)

Output type
PNP/NPN configurable

Switching function
Normally open

Permanent current rating
< 50 mA

Maximum voltage drop
2.5 V

A.2.4 4-20 mA analog output

Load limitations
Maximum loop resistance is determined by the voltage level of the external power supply:

Maximum Loop Resistance = 43.5 × (External Power Supply Voltage - 18) + 600 Ω

Figure A-2: Load Limits
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Analog signal on alarm
The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the analog signal will be driven offscale to alert
the user. High or low failure mode is user-configurable.

Table A-1: Signal on Alarm

Level Custom levels NAMUR NE43 (default)

Low 3.5 to 4.0 mA 3.5 mA (NAMUR ≤ 3.6 mA)

High 20.0 to 22.5 mA 21.5 mA (NAMUR ≥ 21.0 mA)

Analog saturation levels
The transmitter will continue to set a current that corresponds to the measurement until
reaching the associated saturation limit (and then freeze).

Table A-2: Saturation Levels

Level Custom levels NAMUR NE43 (default)

Low 3.5 to 4.0 mA 3.8 mA

High 20.0 to 22.5 mA 20.5 mA

A.2.5 IO-Link specifications

IO-Link revision
1.1

Transfer type
COM2 (38.4 kBaud)

SIO mode
Yes

IO-Link master port
Class A

Minimum cycle time
6 ms
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A.2.6 Configuration

IO-Link configuration tools
Examples:

• Rosemount IO-Link Assistant (available as accessory)

• FDT® frame applications, e.g. PACTware

Damping
User selectable (default is 2 s, minimum is 0 s)

Output units
• Level: in., m

• Temperature: °F, °C

• Volume flow: US gal/h, m3/h

• Signal strength: mV

Output variables

Variable 4-20 mA DO1 and DO2 Digital, service
tools using
IODD

IO-Link PDIn
(to the PLC)

Level ✓ ✓ ✓ ✓

Distance (ullage) N/A N/A ✓ N/A

Volume flow ✓ ✓ ✓ ✓

Electronics temperature N/A N/A ✓ N/A

Signal strength N/A N/A ✓ N/A

Volume flow calculations
• Linearization table

• Parshall flume

• Khafagi-Venturi flume

A.2.7 Process pressure
-15 to 43.5 psig (-1 to 3 bar)

Note
The PE100 flanges must be used only in non-pressurized applications.
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A.2.8 Temperature limits

Process temperature
-40 to 176 °F (-40 to 80 °C)

Ambient temperature
-40 to 176 °F (-40 to 80 °C)

Storage temperature
-40 °F to 194 °F (-40 °C to 90 °C)

A.3 Physical specifications

A.3.1 Material selection
Emerson provides a variety of Rosemount products with various product options and
configurations, including materials of construction that can be expected to perform well in
a wide range of applications. The Rosemount product information presented is intended
as a guide for the purchaser to make an appropriate selection for the application. It is the
purchaser’s sole responsibility to make a careful analysis of all process parameters (such as
all chemical components, temperature, pressure, flow rate, abrasives, contaminants,
etc.), when specifying product, materials, options, and components for the particular
application. Emerson is not in a position to evaluate or guarantee the compatibility of the
process fluid or other process parameters with the product, options, configuration, or
materials of construction selected.

A.3.2 Housing and enclosure

Process connection
NPT 1½-in. or ISO 228/1-G1½-in. thread with a choice of different brackets, adapters, and
flanges

Materials
• Transmitter housing: Polyvinylidene fluoride (PVDF)

• M12 housing: Zinc die-cast nickel-plated

• M12 contact body: Polyamide (PA)

Transmitter weight
0.8 lb (0.35 kg)
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Ingress protection
• IP66/68(4)

• Type 4X/6P

The stated ingress protection only applies when plugged in using a suitable M12
connector that has the appropriate ingress protection.

Impact protection
IK07 (4 J impact test)

A.3.3 Mounting bracket

Materials
• Bracket: Stainless steel 316L

• Nut: PVDF

A.3.4 Flanges

Materials
• Polyethylene PE100

• Stainless steel 316/316L

• Stainless steel 1.4404

A.3.5 Threaded adapters

Materials
Stainless steel 316/316L/1.4404

A.3.6 Material exposed to tank atmosphere
• Antenna and housing: PVDF

• Gasket: EPDM or FKM GLT

• Flange: PE100, 316/316L, or 1.4404

• Threaded adapter: 316/316L/1.4404

(4) IP68 at 9.8 ft. (3 m) for more than 30 minutes.
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A.4 Dimensional drawings
Related information

Type 1 Drawing

A.4.1 Transmitter

Figure A-3: Rosemount 1208A

Ø 3.11 (79)

3.86
(98)

0.79 (20)

0.13 (3)

4.84
(123)

B

C

A

A. NPT 1½-in. or ISO 228/1-G1½-in. thread
B. M12 male connector (A-coded)
C. Gasket

Dimensions are in inches (millimeters).

A.4.2 Threaded adapter

Figure A-4: 2-in. NTP Threaded Adapter

Ø 2.56 (65)

1.46
(37)

Dimensions are in inches (millimeters).
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A.4.3 Mounting brackets

Figure A-5: Standard Version

4.72 (120)

A

5.20 (132)

5.91 (150)

A. For 1- to 2-in. nominal pipe sizes; 2-in. pipe is the recommended size

Dimensions are in inches (millimeters).

Figure A-6: Extendable Version

B

A

A. For 1- to 2-in. nominal pipe sizes; 2-in. pipe is the recommended size
B. Adjustable length: 17.5 to 28.9 in. (445 to 735 mm)
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Bracket hole pattern

Figure A-7: Hole Pattern for Wall Mounting

Ø 0.28 (7)

2.44 (62)

3.23 (82)

Dimensions are in inches (millimeters).
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B Configuration parameters

B.1 Menu tree
Figure B-1: Parameter

Menu > Parameter Basic Setup

OUT1 Digital Output

OUT2 Digital Output*

OUT2 Analog Output

Engineering Units

Reference Height

Write Protection

Digital Outputs P-n

Geometry Reference Height

Advanced Calibration Offset

Upper Null Zone

Bottom Offset

Measurement Recovery Time

Damping Value

General Threshold

Service Tools

Maintenance Device Reset

Restore Factory Settings

Advanced Setup

Simulation

Analog Out Calibration

OUT1 Configuration

DO Control Variable

Alarm Configuration

OUT2 Configuration

Analog Control Variable

Volume Flow Volume Flow Calculation Method

Volume Flow Table/Formula

Alarm Mode

Analog Range Values Upper Range Value (20 mA)

Lower Range Value (4 mA)

Alarm On/Off Delay

Analog Alarm Limits High Alarm Value

High Saturation Value

Low Saturation Value

Low Alarm Value

Set Point Configuration High Alarm

SP1-High Alarm Set Point

SP2-Low Alarm Set Point

Low Alarm

SP1-Hysteresis High Alarm

SP2-Hysteresis Low Alarm

Application Mode

* Contains the same sub-menus as OUT1 Digital Output.
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B.2 Basic setup

B.2.1 Engineering units
Sets the unit of measure for length, temperature, and volume flow.

Option Length unit Temperature unit Volume flow unit

Metric m °C m3/h

Imperial inch °F US gal/h

After appropriate units have been selected, all configuration parameters and transmitter
variables will be expressed in these units.

B.2.2 Reference height
Distance between the Device Reference Point and Zero Level.

Figure B-2: Reference Height

A

B

C

D

A. Device Reference Point
B. Reference Height
C. Zero Level
D. 0.79 in. (20 mm)

Ensure the Reference Height is set as accurate as possible. The transmitter measures the
distance to the product surface and subtracts this value from the Reference Height to
determine the level.

Related information

Enter the reference height
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B.2.3 Digital output P-n
The output polarity for the switching outputs (PnP or nPn).

B.2.4 Write protection
The transmitter can be software write protected to prevent unintentional configuration
changes.

B.3 Digital output

B.3.1 DO control variable
Select between volume flow or level to control the digital output.

B.3.2 Alarm configuration

Alarm delays

Alarm on delay

The time delay for when the digital output transfers from normal to alarm state.

Alarm off delay

The time delay for when the digital output transfers from alarm state to normal.

Figure B-3: Example - High Alarm with Alarm Delays

A

B

C

E F

D

Off

On

A. Level
B. Time
C. SP1 - High alarm set point
D. SP1 - Hysteresis high alarm
E. Alarm on delay
F. Alarm off delay
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Options for alarm on delay
Table B-1: Alarm On Delay

Option Description

Always Alarm on delay is always used.

Lost surface Alarm on delay is used only for lost surface alarms. This may be useful in
applications when there are small and local rapid level changes caused by
surface turbulence.

Hardware faults and measurement values that exceed the alarm set
points will trigger alarm without any delay.

Figure B-4: Behavior of the Alarm On Delay

Always
A

B

C

Off

On
DD

E

Lost surface
A

B

C

Off

On
D

E

A. Level
B. Time
C. SP1 - High alarm set point
D. Alarm on delay
E. Lost surface (invalid level)

B.3.3 Set point configuration

High alarm
Enable or disable the high alarm.
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Low alarm
Enable or disable the low alarm.

Alarm set points

SP1 - High alarm set point

If the measured value is above this set point, the digital output is set to alarm state.

SP2 - Low alarm set point

If the measured value is below this set point, the digital output is set to alarm state.

Hysteresis
The hysteresis is a buffer zone so the alerts do not toggle on and off when the
measurement value fluctuates around the alarm limit. The alarm is set when the value
exceeds the alarm limit. The alarm is then cleared when the value falls outside the
hysteresis zone.

SP1 - Hysteresis high alarm

Hysteresis zone for the high alarm.

SP2 - Hysteresis low alarm

Hysteresis zone for the low alarm.

B.4 Analog output

B.4.1 Analog control variable
Select between volume flow or level to control the analog output.

B.4.2 Upper/lower range value
Enter the range values that correspond to the analog output values 4 and 20 mA. In
normal operation, the transmitter will drive the output in response to volume flow or level
from the lower to upper saturation points.

Note
The 20 mA point should be set below the reduced accuracy zone at the top of the tank.
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Figure B-5: Example of Range Value Settings

B

E

C

D

A

A. Reduced accuracy zone
B. 100% (20 mA)
C. Zero Level
D. Level measurement range 0-100%
E. 0% (4 mA)

Related information

Accuracy over measuring range

B.4.3 Alarm mode
The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the transmitter drives the output to selected
alarm limit (high or low).

B.4.4 Analog alarm limits

High/low alarm value
The high/low alarm current for the analog output when the device enters the alarm mode.

Related information

Analog signal on alarm

High/low saturation value
The device will continue to set a current that corresponds with the measurement until
reaching the upper/lower limit (and then freeze).
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Related information

Analog saturation levels

B.5 Geometry

B.5.1 Advanced

Calibration offset
Difference between surface distance measured by transmitter and the same distance
measured by, for example, hand-dipping with a measurement tape. A positive Calibration
Offset value will increase the presented level value.

Figure B-6: Calibration Offset

A

C

D

B

A. Positive Calibration Offset value
B. Negative Calibration Offset value
C. Reported level
D. Actual level

Upper null zone
The Upper Null Zone defines how close to the device's reference point a level value is
accepted. You can extend this value to block out disturbing echoes close to the antenna,
for example from the tank nozzle.

Note
Make sure the 20 mA value is below the Upper Null Zone. Measurements are not
performed within the Upper Null Zone (UNZ).
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Figure B-7: Upper Null Zone

A

C

E

m

0

mV

0.5

1.0

1.5

2.0

2.5

3.0

0 150 300 450 600 750 900

D

B

A. Upper Null Zone
B. Disturbance echo
C. 100% (20 mA)
D. General threshold
E. Product surface echo

Related information

Change the upper null zone

Bottom offset
The Bottom Offset is defined as the distance between Zero Level and the tank bottom. The
default value is zero.

If the Zero Level is not located at the tank bottom, then enter a Bottom Offset. It is needed
for the transmitter to know the position of the tank bottom.
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Figure B-8: Bottom Offset

A

B

C

D

+

A. Device Reference Point
B. Reference Height
C. Zero Level
D. Bottom Offset

B.6 Volume flow

B.6.1 Volume flow calculation method
Select the preferred volume flow calculation method. The are three options to choose
from:

• Linearization table

• Parshall flume

• Khafagi-Venturi flume

Related information

Set up the volume flow measurement

B.6.2 Volume flow table
The volume flow table is used to convert the measured level into a volume flow rate. Up to
30 level-volume flow pairs can be entered. The level points must be entered in increasing
order.
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B.6.3 Volume flow formula
Parshall Flume

The volume flow is calculated from the formula:

Q = K × Hn

Table B-2: Parshall Flume Parameters

Parameter Description

Q Calculated volume flow in m3/h

H Measured level in m

Constant K Flume specific factor K

Exponent n Flume specific factor n

Maximum level value Flume maximum Level (weir height)

Khafagi-Venturi Flume

The volume flow is calculated from the formula:

Q = K × H1.5

Table B-3: Khafagi-Venturi Flume Parameters

Parameter Description

Q Calculated volume flow in m3/h

H Measured level in m

Constant K Flume specific factor K

Maximum level value Flume maximum Level (weir height)

B.7 Advanced setup

B.7.1 Measurement recovery time
The Measurement Recovery Time (Echo Timeout) parameter controls the maximum time
from when measurement is lost (e.g. due to process conditions such as foam or
turbulence) until it is annunciated. If measurement is recovered within the time specified
by this parameter, then it will not be annunciated.

B.7.2 Damping value
This parameter defines how fast the transmitter reacts to a change of the level value (step
response). The default value is 2 seconds.

A high value makes the level reading steady, while a low value allows the transmitter to
respond to rapid level changes (but the presented level value may be less steady).
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B.7.3 General threshold
The general threshold is used to filter out noise and disturbing echoes from the product
surface echo. The transmitter uses certain criteria to decide which type of echo peak that
is detected. Only echoes above the general threshold might be considered the product
surface.

Figure B-9: Threshold Principle

B
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0 150 300 450 600 750 900
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A. General threshold
B. Product surface echo

Related information

Adjust the general threshold
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